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A Color Managed  
Raw Workflow— 
From Camera to Final Print
The power and control that digital technology brings to photography is drawing more 
and more photographers to adopt it. The immediacy and the spontaneity of digital 
format are addictive. But digital format is not perfect. Getting accurate and predict-
able color is still a challenge to many users, and color management is often a source of 
confusion and frustration. It doesn’t have to be that way.

A digital image in a camera and the printed digital image

The goal is to process a digital image from a camera to a final print as efficiently and  
accurately as possible. But this process can be nonintuitive because the required steps 
are complex, which makes them prone to error. Even after all these years, people still 
make mistakes. But, that’s a far cry from where we were a few short years ago. At least 
today, the process actually works.

The time has mercifully passed when you had to adjust your monitors’ controls to have 
the screen image bear some resemblance to the final output—if you’re still doing that, 
you may need to revisit your workflow because it’s like trying to lift yourself off the 
ground by pulling your shoelaces. Instead, make color management work for you rather 
than against you. Color management is at the core of Adobe® Photoshop®, Camera Raw, 
and printed output—you can’t avoid it, despite the presence of the Color Management 
Off setting in Photoshop software. There’s simply no way to turn color management off 
in Photoshop; Photoshop always displays images through your monitor profile, and it 
always makes some assumptions when you request a color conversion. The answer is to 
be aware of and in control of those assumptions.

You may as well get used to using color management. The good news is that color 
management really works. The bad news is that color management isn’t as easy as we 
all wish it were. However, there are steps you can take to make your own workflow 
less confusing and more efficient. This document is simply intended to help photogra-
phers make accurate prints from their raw captures. For more information about color 
management theory and practices, see Bruce Fraser, Chris Murphy, and Fred Bunting’s 
book Real World Color Management.
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The color management problem
A small amount of theory is necessary to see color management as a solution rather than as a 
meaningless punishment. If you don’t know that there’s a problem, it’s difficult to envisage a 
solution, so let’s take a glance at the problem color management tries to solve.

Computers are amazing inventions, but they know absolutely nothing about color or tone (or art, 
truth, or beauty). They’re very complicated calculators that juggle ones and zeroes to a specified 
order; everything we do with computers involves representing things—text, pictures, sound, 
movies—by numbers. The color management problem stems from the way we typically use 
numbers to represent color.

By various historical accidents, we’ve come to represent the color of pixels by specifying three 
values: a red, green, and blue amount, making up the familiar red, green, blue (RGB) color 
model. An RGB image is made of three grayscale images: One records the red channel, a second 
records the green channel, and a third records the blue channel. RGB color is appealing because 
it directly relates to the way we capture color through red, green, and blue filters (or their  
opposites: cyan, magenta, and yellow) and to the way monitors display images that use red, 
green, and blue phosphors or light-emitting diodes (LEDs). It’s simple, relatively understandable, 
and completely ambiguous to actual color appearance.

Red, green, and blue light combine to make white light.

RGB values are basically control signals that you send to devices such as monitors, or receive 
from devices such as scanners and cameras. The red value in RGB tells a display how many 
electrons to send to the red phosphors to make them emit a specific amount of red light, and the 
red value indicates how many photons passed through the red filter of the scanner or camera to 
record the signal. The problem is that, like people, each device has its own idea of what consti-
tutes the color red (and, for that matter, green and blue). Different scanners and cameras produce 
different RGB values when they are confronted with the same original or scene. Different moni-
tors produce different colors when given the same RGB values because scanners and cameras use 
different filter sets, and displays use different phosphors or LEDs to produce the color.

The first purpose of color management is to render the ambiguous RGB values unambiguous by 
associating them with a specific color as perceived by humans, that is, color appearance. Color 
management accomplishes this goal by associating a profile with each image. Profiles can be 
quite complex, but all you need to know about profiles is that they correlate ambiguous RGB, 
CMYK, and gray device values with numbers in a different system that are directly based on 
human perception. These numbering systems have names like CIE XYZ and CIE LAB. The CIE 
numbering systems specify an actual color appearance (for example, a specific shade of red), so 
they let the profiles tell the color management systems exactly which colors a given set of RBG 
values represent.

The second purpose of color management is to match that specific color appearance as the  
image travels through the reproduction chain from camera, to display, and then to print, but a 
moment’s thought makes it obvious that you can’t match a color appearance until you know what 
the color appearance is. Therefore, the role of color management in specifying color appearance 
is fundamental.

In the analog days when photographers shot film, color management was simply a useful 
tool—photographers had the film itself as a reference for the intended color appearance. But with 
digital capture, color management becomes a necessity because without it, you don’t know what 
you’ve captured.
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Color management setup

A Photoshop machine with a Sony Artisan display and a GTI light box

Color management begins with your monitor. According to the experts, you must have an  
accurately calibrated and profiled display. With an accurately calibrated and profiled display, 
you can have confidence that what you are seeing has a meaningful relationship to your image. 
So if you’re serious about digital photography, a monitor calibration and profiling package that 
includes a measurement device—a colorimeter or spectrophotometer—is essential. So-called 
calibration tools that rely on the unaided eye may be OK for recreational users of Photoshop, but 
the human eye’s powerful adaptability to different lighting conditions makes it highly question-
able for calibrating monitors, where the goal is to return the monitor to the same state each time 
you calibrate it.

The next step toward color management nirvana is to set the color settings in Photoshop to 
define how you will handle color and profiles.

To set the color settings on the Mac®, choose Photoshop > Color Settings,  

or Edit > Color Settings on Windows®.

By default, Photoshop CS comes with its color settings set to North American General Purpose 
(NAGP) with the advanced check box unselected.

NAGP default settings (left), U.S. Prepress Defaults settings (right).
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We suggest that you choose U.S. Prepress Defaults to begin, and then change the settings to suit 
your needs. The U.S. Prepress Defaults settings are better than the NAGP default settings, but 
they’re still less than ideal. For most photographers, we recommend the following changes:

• Change your Gray working space to match the gamma of your RGB working space. 

• Deselect the Profile Mismatches: Ask When Pasting option because you always want to paste 
the color appearance. 

• Deselect the Profile Mismatches: Ask When Opening option. When it’s selected, Photoshop 
displays an alert and presents you with various options when you open an image in a different 
RGB space from the one you’ve selected as your RGB working space. Because you haven’t seen 
the image yet, you almost certainly don’t have any rational grounds for making one choice over 
another. Deselecting the option makes the Preserve Embedded Profiles setting under Color 
Management Policies dictate the color handling, which keeps the profile that was embedded in 
the image and uses that profile to correctly display the image.

• Select the Missing Profiles option. It displays an alert when you open a file that has no profile 
embedded. When you encounter such files, you’ll have guess how to interpret the color, which 
creates extra work.

The suggested color settings.

Be sure your display profile shows up under the RGB Working Space pop-up,  
but don’t choose it as your working space.

Use Photoshop Color Settings to confirm that Photoshop uses the correct display profile by 
opening the RGB Working Space menu. Your display profile is listed as Monitor RGB - {your-
displayprofilename}. Don’t choose your display profile from the menu; just make sure that the 
correct profile is listed. Doing so reduces the chance that you’ll make judgment errors in color 
correction later.

After you’ve changed your color settings, save them with a name that is meaningful to you. Click 
the Save button, and then type a descriptive name in the Save dialog box. Photoshop automati-
cally points you to the correct folder for saving Color Settings (.csf) files. If you need to tempo-
rarily alter your color settings, you can recover your preferred settings by choosing them from 
the Settings menu in Color Settings rather than having to manually set each option.
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When you click the Save button, the Save dialog box appears.

Configuring Camera Raw
After you’ve changed the Color Settings in Photoshop, you can begin to process raw images 
with Adobe Camera Raw. One of the best features of Camera Raw is that all of the heavy color 
management lifting has already been done for you. Camera Raw contains built-in profiles for 
each supported camera and offers a choice of four different output spaces, listed from largest to 
smallest: ProPhoto RGB, Adobe RGB, Colormatch RGB, and sRGB.

The Camera Raw dialog box and the four output spaces.

Camera Raw’s image preview and histogram show the results of the eventual conversion from 
raw to processed image, so rather than relying on expert advice or arcane theory in choosing a 
color space for output, you can actually see the effects of choosing one space or another right in 
the Camera Raw dialog box.

Each output space will render a slightly different histogram.

As you choose different output spaces from the Space menu, you’ll see the histogram change, and 
possibly the image preview. The main difference among the four spaces that Camera Raw supports 
is the color gamut, the range of color, that they can contain.

At this point, we should put to bed the tired myth that digital cameras capture sRGB. The truth 
is that cameras are not limited to capturing a gamut as small as sRGB. Very often, camera sensors 
capture saturated colors that fall outside the gamut of even Adobe RGB. For some images, if the 
goal is to maintain the maximum gamut, the only color space that can do so is ProPhoto RGB.
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This gamut map of the various color spaces shows that there are colors that can be printed on an Epson 2200 
that fall outside both sRGB and even Adobe RGB. ProPhoto RGB can contain all colors that a digital camera can 
capture–even highly saturated colors. Cameras don’t capture and printers don’t print in sRGB color space.

Camera Raw’s histogram is a bar graph that shows the relative population of pixels at each tonal 
level from 0 (black) to 255 (white). White spikes at the right indicate highlight clipping, and 
white spikes at the left indicate shadow clipping, but colored spikes at either end indicate clipping 
of a saturated color.

To show clipping, hold down Option or Alt and move the Exposure or Shadows slider.

You can see exactly what’s being clipped by holding down Option or Alt as you move the  
Exposure slider (for highlight clipping) or the Shadows slider (for shadow clipping). If what’s 
being clipped is important to keep in the image, you may want to try a larger space. But if you see 
saturation clipping (as opposed to highlight or shadow clipping) in ProPhoto RGB, you’ve almost 
certainly made a saturation boost that is driving the color into science-fiction territory. There’s 
no correct or incorrect decision of when and what to clip because that decision depends on the 
image and what you want to do with it. So you should use the histogram as a guide to select the 
output space that does the best justice to the image.

If you find that you consistently use one space more than the others, it’s convenient—but not 
essential—to revisit the Color Settings dialog box and choose that space as the Photoshop RGB 
Working Space. Remember to save the new color settings after you’ve made this change.



7A Color Managed Raw Workflow—
from Camera to Print

To find the RGB space Gamma value, with Advanced enabled, select Custom RGB from the RGB  
Working Space menu. The initial settings are based on the current RGB Space, so you will find 
the Gamma value in the Custom RGB dialog. Don’t make any changes; just note the Gamma 
value, click Cancel, and then change the Gray Working Space value to match your RGB space 
Gamma setting.

If you want to choose ProPhoto RGB as a Photoshop working space,  
you need to select Advanced Mode to be able to choose it.

Camera Raw has one limitation that Photoshop doesn’t have: All Camera Raw adjustments are 
global. The image parameters you choose are applied to all of the pixels in your image. You can’t 
make selective adjustments to parts of the image. So the goal of any image adjustment in Camera 
Raw is for you to get an optimum overall image adjustment, and then make any localized image 
adjustments to postconversion processing in Photoshop, where a broad range of selection tech-
niques is available. Camera Raw is a global adjustment tool, and Photoshop excels at permitting 
local adjustments to an image.

After processing the raw image and opening it in Photoshop, you should be presented with a 
globally optimized image. Depending on your image’s needs, your own desires, and aesthetics, 
you may decide to make more image adjustments or decide to leave the image alone. However, as 
far as color management is concerned, you’re only halfway finished.

Previewing prints
If your final intent is to produce a print, the next steps will either be extremely difficult or lead 
to a satisfying and predictable result. We hope that this document nudges you toward the latter 
outcome.

The marketing-driven view of color management is that its goal is obtaining a color that is 
WYSIWYG (what you see is what you get). The sad truth of the matter is that no printing tech-
nology can reproduce the bright, saturated colors your monitor can display. (Though it’s equally 
true that print can reproduce colors that your monitor can’t display, such as metallics and 
fluorescents, and more importantly, dark saturated colors, particularly in the yellows, oranges, 
greens, and cyans.)

Photoshop has the incredibly useful capability to use a printer profile and alter the display to  
accurately represent what your final print will look like. To use this capability, choose  
View > Proof Setup in Photoshop. (The practice of using this capability is usually referred to as 
soft proofing.) When you soft proof, you choose the exact printer profile, the rendering intent for 
the conversion, and the way you want Photoshop to display the soft proof. You can also turn the 
preview on and off to toggle between the original image and the simulated print.
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The Proof Setup dialog box.

This deceptively simple dialog box contains a lot of power, so it’s worth taking the time to under-
stand what each setting actually does.

The Profile menu lets you choose the profile for the print process you want to simulate, which 
may be a profile from a photo printer on your computer to a printing press on the other side of 
the planet.

The Profile settings that you can change to fit your image’s needs

The Preserve Color Numbers option is available only when both the image and the selected 
printer profile share the same color mode—for example, an RGB image and an RGB printer 
profile or a CMYK image and a CMYK printer profile. This option shows you the outcome if 
you simply send the image with no conversion to the printer that has the profile you selected. As 
such, it provides a dramatic illustration of how badly you need color management, but otherwise 
has little practical use for most photographers.

The Intent box lets you choose a rendering intent for the conversion from the image’s source 
space to the simulated print space. You can think of rendering intents as different ways of han-
dling out-of-gamut colors (that is, colors that are present in the source image that the destination 
printer is incapable of reproducing). For most photographic images, the choice is between Per-
ceptual and Relative Colorimetric, but one of the more useful aspects of the Proof Setup dialog 
box is that you can see what happens to the image as you choose different rendering intents.

The Intent settings that you can change to fit your image’s needs.

The Use Black Point Compensation option is a proprietary Adobe feature that ensures that the 
source image gets converted in such a way that it uses the full dynamic range of the output device. 
We suggest you always leave this option selected. 

All of the aforementioned settings control the conversion from the source image to the simulated 
print. However, the last two Simulate options, Paper White and Ink Black, control the way that 
simulation gets rendered to your screen. These options require some care to effectively use them.

The Simulate options that you can select to fit your image’s needs

When both options are unselected, Photoshop translates the simulated paper white to the bright-
est white and simulated printed black to the darkest black that your monitor can display. If you’re 
printing to a bright, glossy photo paper, this view is remarkably accurate, but for lower dynamic 
range processes, such as watercolor or uncoated rag paper on an inkjet, this view may produce an 
overoptimistic example of the final contrast of the print.
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You can select Ink Black to lighten the shadows to show the literal tone of printed black. You can 
select Paper White to show both the literal tone of printed black and of paper white. But when 
you select these options, Photoshop has to display the simulated paper white as something darker 
than monitor white and the simulated ink black as something lighter than monitor black, so the 
image suddenly looks much worse than it did when the options were unselected.

Compared to a high-quality image in Photoshop, the image looks flat and dim, and the colors 
appear unsaturated. This image is actually a reasonable prediction of your print. Images printed 
with ink on paper simply can’t contain the same dynamic range as an image on a computer’s 
screen. The printed color black is much lighter than on the screen, and the maximum luminosity 
of the paper white is very dim and often contains a slight colorcast. The trick is to use Photoshop 
soft proofing to make your image look as good as your paper, ink, and printer can make it.

Soft proofing with Paper White and Black Ink unselected (left) and selected (right)

The screen on the left has white user interface elements that interfere with the eye’s white adaptation. 
The screen on the right has the palettes and tool bar hidden by pressing Tab and a black background produced 
by pressing F twice. You can also select the Full Screen mode button from the Tools palette.

Here are two pieces of useful advice when using the Simulate options. First, when you select the 
Paper White option, it’s extremely important that you hide any white user interface elements 
before attempting to evaluate the image. Our eyes seek out the brightest object in the scene, 
interpret it as white, and judge all of the other colors relative to that perceived white. If you hide 
the white user interface elements, your eye adapts to the simulated paper white, which lets you 
see the objects that are on-screen as a reasonable rendition of the image. Second, look away from 
the screen when you select the Paper White option. By looking away, you see a simulation of the 
true rendition of the eventual print.
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Proof Setup on the View menu contains a list of saved settings, so if you find yourself using the 
same setup over and over again, you can save this setting, and then directly choose it from the 
View menu.

By saving the Proof Setup, you can have your custom setup appear in the Proof Setup list.

One of the Proof Setup simulation’s greatest features is that the simulation is live, so you can 
edit the image while viewing the simulated print. To edit the image while viewing the simulated 
print, you need to duplicate your original image. For the duplicate, keep the Proof Colors option 
unselected. Move the duplicate next to your original image that has the Proof Colors option 
selected, and then compare the two interpretations.

The image on the left is the duplicate. The image on the right has the Proof Colors option selected.

Generally, you can make some fine adjustments to your image to make it look as good as possible 
before you actually print it. While the exact correction varies, you’ll need to adjust the overall 
contrast of your image by soft proofing. You may also want to adjust the overall color saturation, 
and perhaps the precise saturation of specific colors, all of which is relatively easy to accomplish 
by using Adjustment Layers. Even though you can never make a print look as good as it can look 
on-screen, you can make substantial improvements over the simple and relatively nonspecific 
rendering the unaided color profiles offer. The aim is to make the print look as good as it can, 
before you spend the time, ink, and paper to print it.
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The top left shows a slight increase in the image contrast for an image. The lower left shows a saturation 
increase for the image. Both of these settings improved the image’s rendering.

After soft proofing and putting the printer and paper–specific corrections in a layer set (which is 
useful if you plan to make additional prints in the future), you’re ready to print your image. You 
can now close your duplicate image without saving it because it’s served its purpose.

The original RGB image (left), and the soft proofed and adjusted image using the Adjustment Layers option (right)
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Making the print
You’re in the home stretch, but this is where things get tricky. You need to pay close attention to 
mechanical, but critical, settings when printing. There are about 50 possible combinations of set-
tings, and most of them do not produce good results. The following print path seems to be very 
reliable, so we suggest you follow it unless you find it doesn’t fit your needs.

You should always print from the Print With Preview dialog box in Photoshop. This dialog box 
offers you the very useful capability of performing the conversion to printer space on-the-fly as 
part of the print stream, so you don’t end up with several images that have been hard-converted 
to printer space (which makes them less than optimal for any use, other than printing to the 
print condition for which they’ve been converted).

The default presentation of the Print with Preview dialog box (left). Select Show More Options to display 
advanced color management options (right).

By default, the dialog box does not have Show More Options selected, so you need to select this 
option. Select the Color Management option. Two settings will appear: Source Space and Print 
Space. It’s critical that these settings are correct—there’s no room for error here or in subsequent 
dialog settings.

For Source Space, you’re given two choices: Document and Proof. If you’ve used Proof Setup as 
we suggested and you want to preview the final print conversion, you can choose either option, 
but you’ll need to make different settings for Print Space depending on which option you choose. 
The goal is to perform one single conversion from the document space to the Print Space, but it’s 
distressingly easy to wind up doing more than one conversion and hence obtaining disappoint-
ing results.

If you choose Document as your Source Space, you need to choose the printer profile that you 
used in Proof Setup in the Profile box, and the Intent and Black Point Compensation settings 
that you determined were the best ones for the image by using Proof Setup.

If you choose Proof as your Source Space, you need to choose Same As Source in the Profile box 
under Print Space. All of the other settings in Print Space then become dimmed.

If you choose Proof as your Source Space, you need to choose Same As Source under Print Space. Either setting 
produces the same results, but you must be very sure of your Proof Setup settings because they control the 
rendering intent and whether Black Point Compensation is used.
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Both do exactly the same thing: They tell Photoshop to convert the data that is being sent to the 
printer from Document space to the printer profile by using the specified Intent and Black Point 
Compensation settings.

At this point, Photoshop is still in control. Your final step is to configure the actual printer 
driver, while keeping in mind that it has no knowledge of what Photoshop has already done, and 
Photoshop has no knowledge of what the driver will subsequently do. You need to correctly set 
two very important settings.

In Mac OS computers, Print Settings control media and resolution (left). The Color Management option (right) 
lets you select No Color Adjustment in the driver.

The first important group of settings is the media type and the associated print parameters, 
such as print quality and resolution. These settings control the amount of ink the printer lays 
down, so it’s critical that they match both the actual paper stock and the printer profile you’re 
using. Profiles are paper-specific, so using a glossy paper profile on matte paper or vice versa 
will almost invariably produce hideous results.

The second important setting is the color management parameters. If you’ve used Photoshop to 
control your color transforms, it’s critical that you don’t also let the printer driver control them 
too; otherwise you get a second conversion on top of the one that Photoshop has already done. 
On Epson printers, the option that disables driver-level color management is No Color Adjust-
ment. Other vendors may use different terminology, but the principle remains the same.

The dialog boxes and the locations of the printer driver settings vary between Mac OS and 
Microsoft® Windows. The specific settings are consistent across platforms. You need to set the 
media type and print parameters, and then turn off the driver’s color management parameters.

In Windows, click Properties, and then select Advanced. You need to set the media type, resolution,  
and No Color Adjustment for the Windows printer driver.
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The image on the left is a color-managed screenshot of the actual soft-proofed page. The image on the right is 
a digital capture of the image printed and displayed on a GTI Daylight light box. Considering all of the iterations 
and media involved (screenshots and a copy shot of the print), it’s a close match.

Now your end print should match the Photoshop soft proof accurately. The potential for error 
is anywhere, but there are two common errors resulting from improper settings. If your image 
is overly dark with a greenish cast, it’s likely that both the Photoshop color management and 
your printer driver’s color management settings are turned off, which result in no color man-
agement being applied. If the print is too light with a magenta or red cast, it’s likely that the 
Photoshop and the printer driver’s color management are both turned on. This double color 
management is very common.

The workflow in a nutshell



On one hand, using color management in Photoshop and Camera Raw is relatively easy 
if you precisely follow the correct steps in the correct order. On the other hand, it’s quite 
complicated and has the potential of making mistakes at almost every turn. The process 
will get better. Talented people are working to improve and streamline the process.  
Until that time though, you have to learn the steps and exert control over the process. 
The good news is that this process works. You can process an image from camera to 
print in an accurate, consistent, and predictable manner and achieve a high degree of 
quality from digital images if you correctly use color management.
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